BAB 2
TINJAUAN PUSTAKA DAN DASAR TEORI

Bab 2 membahas mengenai penelitian-penelitian terdahulu terkait penurunan
untuk mengetahui beberapa akar masalah yang pernah ada, metode yang akan
digunakan untuk mencari akar masalah tersebut, dan usulan solusi yang dapat
diberikan. Pembahasan lainnya yaitu tentang dasar teori dari beberapa literatur
mengenai bauran pemasaran, riset pemasaran, preferensi dan karakteristik

konsumen hingga metode-metode yang akan digunakan.

2.1. Tinjauan Pustaka

2.1.1. Penelitian Terdahulu Mengenai Penurunan Penjualan

Ada banyak sekali penelitian terdahulu mengenai penurunan penjualan dan sangat
bervariasi akar masalahnya. Pada bagian ini variasi akar masalah terbagi menjadi
tiga kategori yaitu akibat perilaku konsumen yang berubah atau yang tidak
diketahui oleh pemilik objek penelitian dan strategi pemasaran yang tidak

disesuaikan dengan perkembangan zaman.

Pada kategori pertama, penelitian-penelitian terdahulu yang menemukan akar
masalah ini antara lain Dana dan Suci (2021), Rachman dan Santoso (2014),
Saefudin dkk. (2020), dan Mulya dkk. (2019). Objek penelitian dan metode dari
keempat peneliti ini unik dan berbeda satu sama lain. Ada yang merupakan
produsen produk BUMDes (Dana dan Suci, 2021) dengan analisis faktor, penyedia
makanan di kampus (Mulya dkk., 2019) dengan metode data mining dengan
algoritma apriori, toko kaos distro (Rachman dan Santoso, 2014) dengan metode
analisis regresi linear berganda, dan kedai kopi (Saefudin dkk., 2020) dengan Uji
Mann-Whitney U.

Kategori kedua memiliki literatur yang lebih sedikit daripada kategori pertama,
yaitu tiga literatur. Ketiga literatur tersebut adalah penelitian oleh Muzdalifah
(2017) yang menggunakan metode komparatif untuk melihat seberapa
berpengaruhnya media sosial untuk media promosi Rumah Pengantin L’Sinta
Sidoarjo, penelitian oleh Widiyarini dan Hunusalela (2019) yang menggunakan
metode SWOT dan QSPM untuk menemukan strategi yang tepat bagi PT
Primavista Solusi sesuai dengan keadaan saat ini, dan penelitian oleh Sutiarkoro
(2018) yang menganalisis strategi pemasaran yang menarik bagi UD. Rainbow

Creative. Seluruh penelitian terdahulu ini dapat dilihat pada Tabel 2.1.



Tabel 2.1. Penelitian Terdahulu Mengenai Penurunan Penjualan

Penulis Tahu Objek Akar Penyebab Kategori Metode Hasil
n Penelitian Masalah Permasalahan Analisis
Produk Berubahnva Penurunan penjualan produk BUMDes di
Dana dan 2021 BUMDes di selera y Perilaku Analisis Kabupaten Karangasem dipengaruhi oleh
Suci Kabupaten K konsumen Faktor faktor perubahan selera konsumen dan
onsumen. .
Karangasem harga lebih rendah.
Tidak
Rachman Toko Kaos mengetahui . Regresi . : .
dan 2014 | Distro Jolly keputusan Perilaku o\ Desain produk_, citra merek, dan promosi
: konsumen mempengaruhi keputusan pembelian.
Santoso Roger pembelian Berganda
konsumen.
Semakin
berkembangnya
e-marketing
Rumah oleh kompetitor Penggunaan media sosial seperti
. Pengantin sedangkan Strategi Metode Instagram dan Facebook untuk
Muzdalifah | 2017 | | ,&. . . . : . .
L'Sinta objek penelitian | pemasaran Komparatif | mempromosikan jasa dapat menghasilkan
Sidoarjo masih peningkatan penjualan.
menggunakan
promosi melalui
word of mouth.
Saefudin Kedai Kopi Preferensi Perilaku Uji Mann- Penyebab meningkatnya keda_l_kompetltor
2020 | . konsumen yang . adalah harga yang murah, fasilitas yang
dkk. Jigana konsumen Whitney U .
berbeda. lengkap, dan suasana kedai.




Tabel 2.1. Lanjutan

Penulis Tahu Objek Akar Penyebab Kategori Metode Hasil
n Penelitian Masalah Permasalahan Analisis
Strateqi Hasil analisis menyebutkan bahwa
emasgaran hendaknya UD. Rainbow Creative dapat
. UD. Rainbow | P Strategi Metode mengembangkan produk, memperluas
Sutiarkoro | 2018 . yang kurang !
Creative A Pemasaran SWOT pemasaran produk di luar daerah
menarik minat : o
K Semarang, dan mengoptimalkan distribusi
onsumen. :
produk hingga ke konsumen.
Semakin
meningkatnya
persaingan
yang
menyediakan
Widiyarini jasa payment Perusahaan dapat melakukan beberapa
, . ! / Metode . . :
dan PT Primavista | solution Strategi alternatif solusi seperti pengembangan
2019 . . . SWOT dan
Hunusalel Solusi sehingga objek | pemasaran QSPM produk, pengembangan pasar, dan
a penelitian perlu penetrasi pasar.
menemukan
strategi yang
sesuai dengan
keadaan saat
ini.
: Metode Menu Indomie, telur balado, ayam goreng,
Strategi
- ) Data dan rendang merupakan menu terpopuler
Kantin di penjualan yang . o . . .
. ; : Perilaku Mining sehingga hendaknya kantin meningkatkan
Mulya dkk. | 2019 | Universitas kurang sesuai K d di K b i
Tanri Abeng dengan perilaku onsumen engan persediaan keempat menu tersebut. Selain
Algoritma itu menu nasi atau es teh dapat ditambah

konsumen.

Apriori

di sebelah keempat menu tadi.




Berdasarkan penelitian-penelitian terdahulu tersebut dapat disimpulkan bahwa
akar masalah sebuah penurunan penjualan sangat beragam dan unik. Akar
masalah tersebut dapat berupa strategi penjualan yang kurang tepat, strategi
promosi yang masih ketinggalan zaman, meningkatnya kekuatan kompetitor
sehingga harus mengevaluasi strategi, dan tidak diketahuinya perilaku konsumen
saat ini. Hal ini dapat menjadi beberapa gambaran umum mengenai akar masalah

apa saja yang mengakibatkan menurunnya penjualan.

2.2. Dasar Teori

2.2.1. Bauran Pemasaran

Menurut Kotler dan Amstrong (2018) bauran pemasaran merupakan sebuah alat
pemasaran yang digunakan untuk menghasilkan bentuk respon dari keinginan
masyarakat dengan melibatkan konsumen dan memberikan nilai kepada
konsumen. Penggunaan bauran pemasaran dibagi menjadi empat variabel yaitu
product (permintaan konsumen), price (biaya yang dikeluarkan oleh konsumen),
place (bagaimana perusahaan mencapai konsumen), dan promotion (komunikasi
kepada konsumen) (Chaffey dan Ellis-Chadwick, 2016).

2.2.2. Promosi

Promosi merupakan aktivitas yang mengkomunikasikan nilai-nilai produk yang
disediakan agar konsumen merasa tertarik untuk membeli produk tersebut (Kotler
dan Amstrong, 2018). Dalam melakukan promosi, terdapat lima jenis alat promosi
antara lain periklanan, personal selling, promosi penjualan, hubungan masyarakat
(Public Relation) serta pemasaran langsung seperti melalui sosial media atau

datang langsung ke calon konsumen.

Definisi dan fungsi dari masing-masing alat promosi tersebut berbeda-beda.
Periklanan merupakan sebuah aktivitas presentasi nonpersonal dan promosi
terhadap segala ide, produk, maupun jasa kepada konsumen. Bentuk dari
periklanan sangat beragam, mulai dari koran, online, radio, dan lain-lain. Menurut
Kumar dkk. (2018), periklanan akan mempengaruhi pemasaran untuk jangka
waktu yang panjang. Berbeda dengan periklanan, promosi penjualan merupakan
sebuah aktivitas yang dapat meningkatkan penjualan dengan waktu yang singkat
dengan menggunakan diskon, kupon, sampel produk, dan lain-lain. Personal
selling merupakan segala bentuk pelayanan yang dilakukan kepada konsumen
untuk meningkatkan penjualan dan bahkan hubungan dengan konsumen. Hal

yang dapat dilakukan untuk meningkatkan promosi dari personal selling antara lain



interaksi dengan konsumen, kecepatan pelayanan, dan lain-lain. Public Relation
adalah salah satu alat promosi yang bertujuan untuk memberikan citra perusahaan
yang positif dari kegiatan-kegiatan yang telah diikuti oleh perusahaan. Kegiatan-
kegiatan tersebut antara lain aktivitas sosial, sponsor terhadap sebuah acara,

pembuatan acara tertentu terkait perusahaan, dan lain-lain.

Bauran promosi yang terakhir adalah direct marketing (pemasaran langsung).
Pada dasarnya direct marketing bertujuan untuk meningkatkan penjualan dengan
memasarkan nilai-nilai produk kepada individu yang spesifik menggunakan media-

media seperti surat elektronik, whatsapp, telepon, dan lain-lain.

2.2.3. Karakteristik Konsumen

Pemahaman dan pengetahuan akan sikap konsumen dalam berbelanja adalah
dasar dari pemasaran (Chaffey dan Ellis-Chadwick, 2016). Pengetahuan akan
karakteristik konsumen dapat dilihat melalui demografi, geografi, dan psikografi
yang dimiliki (Siregar dkk., 2015). Variabel demografi menurut Doherty dan Ellis-
Chadwick (2010) dalam Chaffey dan Ellis-Chadwick (2016) adalah atribut pribadi
yang selalu melekat pada diri manusia dan bersifat statis atau berkembang
perlahan mengikuti zaman seperti umur, jenis kelamin, keluarga dan rumah
tangga, kelas sosial, etnis (Leon dan Kanuk, 2014), tahap hidup, pendapatan, dan
generasi (Wiguno dkk., 2015). Menurut Chhabra (2015), variabel geografi
merupakan karakteristik konsumen yang dibagi berdasarkan zona-zona yang telah
ditentukan. Menurut Chaffey dan Ellis Chadwick (2016) variabel psikografis
merupakan perilaku yang didasari oleh persepsi, keyakinan, dan sikap konsumen
dalam berbelanja seperti pengetahuan, sikap, inovasi, penghindaran risiko
(Chaffey dan Ellis-Chadwick, 2016), gaya hidup, dan motivasi (Rinawiyanti dkk.,
2014).

2.2.4. Minat Beli

Menurut Jahja (2011) dalam Amalia (2020), minat dapat didefinisikan sebagai
pemikiran pada situasi seseorang terhadap tindakan yang akan dilakukan
selanjutnya dan perilaku tersebut dapat diprediksi. Menurut Umar (2002) dalam
Amalia (2020), minat beli adalah sebuah bentuk perilaku konsumen dalam
mengkonsumsi dan bertindak sebelum keputusan pembelian benar-benar
dilaksanakan. Menurut Ferdinand (2006) dalam Amalia (2020) minat beli dapat
diukur melalui empat indikator yaitu minat transaksional (minat konsumen dalam

membeli produk), minat referensial (minat konsumen untuk mereferensikan produk



kepada orang di sekitarnya), minat preferensial (minat konsumen untuk
menjadikan produk referensi), dan minat eksploratif (minat konsumen untuk selalu

mencari informasi produk).

2.2.5. Riset Pemasaran

Menurut American Marketing Association (AMA) (2017) riset pemasaran adalah
sekumpulan informasi yang didapat melalui identifikasi sebuah peluang dan
masalah yang ada lalu dievaluasi dan dikembangkan sehingga menghubungkan
antara konsumen dengan pemasar. Riset pemasaran membutuhkan berbagai
macam informasi yang spesifik mengenai isu tersebut lalu diolah dengan metode

yang telah ada, menganalisa hasilnya, dan mengkomunikasikan hasil tersebut.

Selain menurut AMA, menurut Burns dan Bush (2019) riset pemasaran memiliki
definisi sebagai proses memecahkan masalah pemasaran dengan mencari
informasi, memetakan, dan menganalisa masalah tersebut dengan pendekatan-
pendekatan tertentu. Menurut Sathyapriya (2015) riset pemasaran merupakan
sebuah gambaran permasalahan pasar dengan kondisi tertentu yang melibatkan
pengumpulan dan analisa data untuk menyelesaikan permasalahan pemasaran

tersebut.

Berdasarkan pengertian yang dipaparkan oleh AMA, fungsi dari riset pemasaran
adalah menghubungkan antara konsumen dengan pemasar. Hal ini menjadi
sangat penting karena konsumen akan mendapatkan nilai sebuah produk atau
jasa yang sesuai dengan ekspektasi mereka. Apabila ekspektasi tersebut
terpenuhi maka riset pemasaran dapat membantu perusahaan dapat mengurangi
ketidakpastian yang dihasilkan oleh konsumen karena informasi yang telah
terkumpul. Pernyataan tersebut berujung kepada kesimpulan bahwa riset
pemasaran membantu untuk mengetahui apa, mengapa, dan bagaimana sebuah
permasalahan dapat diselesaikan dan hasilnya akan membantu perusahaan

dalam bertumbuh (Sathyapriya, 2015).

Untuk menghasilkan sebuah riset pemasaran yang tepat, diperlukan proses yang
terstruktur. Apabila sebuah riset pemasaran dilakukan tidak terstruktur maka
tujuan dari riset pemasaran tersebut bisa saja salah sehingga membuang waktu
dan uang peneliti. Menurut Kotler dan Armstrong (2018), terdapat lima tahapan
dalam melakukan proses riset pemasaran, penjelasan tersebut dipaparkan pada
poin-poin berikut.

1. Menentukan tujuan dan masalah penelitian



Langkah pertama dalam melakukan proses riset pemasaran adalah dengan
menentukan masalah penelitian. Hal ini dikarenakan penentuan masalah pada
suatu penelitian adalah tindakan kreatif seorang peneliti (Kumar dkk., 2018).
Apabila penentuan masalah sudah keliru sejak awal, maka akan berdampak
kepada tujuan dari riset yang salah dan mempengaruhi seluruh riset pemasaran
(Jr. dan Gates, 2020). Hal selanjutnya setelah mengetahui masalah pada sebuah

riset adalah dengan menentukan tujuan penelitian.

Menurut Kotler dan Armstrong (2018) terdapat tiga jenis tujuan penelitian yaitu
tujuan eksplorasi, tujuan penelitian deskriptif, dan tujuan dari penelitian klausal.
Tujuan penelitian eksplorasi merupakan pengumpulan informasi awal untuk
mendapatkan hipotesis yang akurat. Tujuan penelitian deskriptif adalah untuk
mendeskripsikan hal seperti potensi pasar, demografi, dan lain-lain. Tujuan
penelitian klausal adalah untuk menguji sebuah hipotesis mengenai hubungan
sebab-akibat.

2. Menyusun rencana penelitian

Setelah menentukan tujuan dan masalah penelitian, diperlukan penentuan data-
data yang perlu digunakan, merancang rencana agar dapat mengumpulkan data
tersebut dengan efisien, dan mengatur rencana-rencana tersebut. Penentuan data
memerlukan informasi spesifik seperti pendekatan, rencana pengambilan sampel,
instrumen yang akan digunakan, dan metode yang sesuai dengan tujuan dan
masalah penelitian.

3. Mengumpulkan data sekunder

Sebuah penelitian berawal dari pengumpulan data sekunder. Pengumpulan data
ini diperoleh melalui berbagai macam sumber dan salah satunya adalah data
internal perusahaan. Oleh karena data ini berasal dari pihak kedua maupun ketiga,
data yang dikumpulkan harus relevan dengan penelitian, akurat, sesuai dengan
kondisi sekarang, dan netral (Kotler dan Armstrong, 2018).

4. Mengumpulkan data primer

Selain data sekunder diperlukan data primer yang dapat mendukung hasil dari riset
pemasaran. Menurut Kotler dan Armstrong (2018) dalam mengumpulkan data
primer diperlukan rencana-rencana seperti pendekatan riset, cara mencapai

responden, rencana sampling, dan instrumen riset.

Menurut Sathyapriya (2015) pengumpulan data primer dapat diperoleh melalui tiga
cara yaitu observasi, survey, dan eksperimen. Observasi merupakan cara

melakukan pendekatan dengan langsung mengobservasi orang-orang yang
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sesuai dengan kriteria riset. Survey merupakan cara untuk melakukan pendekatan
dengan menanyakan kepada yang bersangkutan mengenai hal-hal yang sesuai
dengan riset. Eksperimen merupakan cara untuk mendapatkan informasi

mengenai sebab-akibat suatu permasalahan.

Untuk mendapatkan informasi, terdapat empat metode agar dapat mencapai
responden. Metode tersebut antara lain dengan email, telepon, wawancara
personal, dan online. Dengan menentukan metode yang tepat untuk mencapai

responden, maka akan mempermudah peneliti dalam mendapatkan informasi.

Penentuan sampling memerlukan tiga keputusan vyaitu siapa yang akan
diwawancarai, berapa banyak responden yang diperlukan, dan bagaimana

karakteristik responden yang tepat.

Menurut Bluman (2012), metode probability sampling dapat berupa simple random
sampling, systematic sampling, stratified sampling, cluster sampling, sequence
sampling, double sampling, dan multistage sampling. Setiap metode tersebut
memiliki definisi dan cara pengambilan sampel yang berbeda-beda. Pada random
sampling cara pengambilan sampel dapat dilakukan dengan memilih responden
secara acak dari sebuah populasi lalu systematic sampling juga mengambil
sampel dengan acak namun ada ketentuannya seperti mengambil sampel pada
saat responden mencapai nomor responden kesekian. Stratified dan cluster
sampling memiliki kesamaan yaitu membagi populasi menjadi beberapa
kelompok, namun stratified mengelompokkan populasi berdasarkan karakteristik
yang sama sedangkan cluster membagi populasi menjadi klaster yang memiliki
kemiripan dengan Kklaster lainnya. Sequence sampling merupakan teknik
pengambilan sampel yang digunakan pada proses quality control dengan
mengambil succesive unit sebagai sampel untuk melihat seberapa baik unit-unit
lainnya. Metode pengambilan sampel selanjutnya adalah double sampling.
Metode ini merupakan sebuah metode yang memberikan kuesioner kepada
populasi yang sangat besar untuk dilihat sampel mana saja yang lolos kualifikasi
penelitian lalu sampel yang lolos tersebut dapat melanjutkan tahap kuesioner yang
berikutnya. Metode yang terakhir yaitu multistage sampling. Multistage sampling
merupakan metode pengambilan sampel dengan menggabungkan beberapa
metode lainnya. Contoh penggunaan metode ini adalah dengan menggabungkan

metode cluster sampling lalu dilanjutkan dengan random sampling.
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Menurut Sathyapriya (2015) metode pengambilan sampel lainnya dapat berupa
convenient sampling, purposive sampling, quota sampling, dan snowball sampling.
Pengambilan sampel ini dapat disebut dengan non-probability sampling method.
Metode ini tidak menggunakan probabilitas yang sama pada sebuah populasi dan
elemen-elemen sampel responden didapatkan melalui asumsi peneliti. Convenient
sampling merupakan pengambilan sampel berdasarkan kemudahan dalam
pengumpulan data dan pendekatan responden. Purposive sampling merupakan
pemilihan sampel melalui penetapan kriteria dan syarat kepada calon responden.
Quota sampling merupakan pemilihan sampel dengan memberikan kuota
terhadap setiap klasifikasi. Terakhir, snowball sampling adalah metode pemilihan
sampel dengan menggunakan responden untuk mengajak calon responden

lainnya agar meningkatkan jumlah responden pada penelitian

Menurut Kotler dan Armstrong (2018) terdapat dua jenis instrumen yang dapat
digunakan dalam riset pemasaran. Instrument yang pertama yaitu kuesioner
dimana responden akan diberikan pertanyaan closed-ended yang berisi jawaban-
jawaban yang tepat sehingga responden dapat mengisi pertanyaan dari rentang
jawaban tersebut. Instrument kedua adalah alat-alat seperti GPS yang dapat
mengukur perilaku konsumen.

5. Mengumpulkan dan menganalisis data yang diperoleh

Dalam tahap ini diperlukan metode-metode yang mendukung agar data yang
dikumpulkan dan yang akan dianalisis terjamin kualitas dan keakuratannya.
Apabila sudah sesuai dengan kriteria, maka peneliti dapat melanjutkannya dengan

melakukan tabulasi dan mengkomputerisasi hasil.

2.2.6. Perancangan Instrumen Kuesioner

Kuesioner merupakan salah satu instrumen yang sering digunakan dalam
mengumpulkan data primer saat riset pemasaran (Kotler dan Armstrong, 2018).
Terdapat tiga tujuan dalam merancang sebuah kuesioner yaitu mendapatkan
informasi dari pertanyaan-pertanyaan spesifik yang dilontarkan ke responden,
meringankan tuntutan responden yang harus diwawancarai, dan meminimalisir
eror (Malhotra, 2013). Pada poin-poin berikut terdapat pedoman langkah-langkah
dalam merancang sebuah kuesioner yang telah dijabarkan oleh Malhotra (2013).
1. Menentukan informasi yang dibutuhkan dan cara mendapatkannya

Dengan permasalahan yang spesifik, hipotesis, dan pertanyaan pendahuluan,

akan membuat pertanyaan pada kuesioner tetap pada jalurnya. Pengumpulan
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data perlu dipikirkan secara matang agar data yang diperoleh akurat dan sesuai
dengan kebutuhan peneliti. Terdapat beberapa cara untuk memperoleh informasi
seperti interaksi tatap muka, penggunaan surat elektronik, atau menggunakan
kuesioner via internet.

2. Merancang pertanyaan pada kuesioner

Perancangan pertanyaan sebuah kuesioner memiliki tiga Kklasifikasi yaitu
pertanyaan terbuka atau tertutup, pertanyaan spontan atau terarah, dan
pertanyaan open-ended atau pre-coded. Pertanyaan terbuka merupakan
pertanyaan yang menggunakan isian singkat sedangkan tertutup menggunakan
pilihan ganda. Pertanyaan spontan adalah pertanyaan yang digunakan untuk
mendeskripsikan sesuatu sedangkan terarah terdapat pilihan didasari batasan
oleh peneliti. Pertanyaan open-ended merupakan pertanyaan yang tidak
terstruktur dan bebas, sedangkan pre-coded merupakan pertanyaan yang

terstruktur, terbatas, dan menggunakan pilihan ganda sebagai alat ukurnya.

Menurut Sathyapriya (2015) terdapat beberapa pengukuran yang dapat menjadi
pedoman dalam merancang jawaban yang sesuai dengan tujuan penelitian antara
lain:

a. Skala Nominal

Skala nominal biasa digunakan dalam mengidentifikasi konsumen dengan
memberikan kode angka yang menginterpretasikan sebuah tindakan maupun
kejadian.

b. Skala Ordinal

Skala ordinal digunakan untuk menghasilkan jawaban dengan skala berupa urutan
naik atau menurun.

c. Skala Interval

Skala interval menyajikan jawaban skala berupa penilaian yang memiliki jarak
tertentu. Penggunaan skala ini ada pada pengukuran tingkat kepuasan konsumen.
d. Skala Rasio

Skala rasio merupakan skala yang biasa digunakan dalam mengukur umur, tinggi

badan, dan berat badan.

2.2.7. Validitas dan Reliabilitas
Menurut Hair dkk. (2010) penggunaan beberapa variabel dan variat tidak akan
lepas dengan measurement error. Istilah ini digunakan sebagai tolak ukur

seberapa jauh nilai yang telah diamati mendekati atau mewakili nilai yang benar.

13



Measurement error memiliki banyak sebab mulai dari data yang kurang tepat,

kesalahan pengukuran, hingga jawaban responden yang tidak memberikan

informasi yang sesuai. Oleh karena itu, menurut Hair dkk. (2010) seluruh variabel

yang digunakan pada analisis multivariat perlu memiliki sebuah derajat kesalahan.

Cara untuk mengurangi tingkat derajat kesalahan adalah dengan menggunakan

dua karakteristik penting bagi pengukuran seperti uji validitas dan reliabilitas.

A. Validitas

Validitas merupakan sebuah derajat yang mengukur seberapa akurat data

tersebut diukur. Dalam Hair dkk. (2010), validitas dicontohkan sebagai pengukuran

terhadap penghasilan tambahan. Apabila akan dilakukan pengukuran terhadap

variabel tersebut, maka pertanyaan yang diberikan kepada responden bukan

berupa gaji per bulan. Oleh karena itu, validitas dapat dipastikan melalui

pemahaman terhadap apa yang akan diukur dan menghasilkan pertanyaan yang

sesuai dan seakurat mungkin. Saat ini pengujian validitas analisis multivariat dapat

dilakukan dengan berbagai macam alat dan salah satunya adalah SPSS. Menurut

Ramadhayanti (2019) langkah-langkah pengujian uji validitas melalui SPSS

adalah sebagai berikut.

i. Buka software SPSS dan pilih Menu File > Import > Excel.

ii. Setelah data Excel terimpor, langkah selanjutnya adalah dengan klik Analyze >
Correlate > Bivariate

iii. Pindahkan seluruh profil di kotak Bivariate Correlations ke kotak Variable.

iv. Pastikan Correlation Coefficients menggunakan Pearson dan Test Of
Significance menggunakan Two-Tailed.

v. Klik ‘OK’

B. Reliabilitas

Selain validitas, reliabilitas juga dapat berpengaruh terhadap hasil analisis data.

Reliabilitas merupakan derajat yang dapat mengukur sejauh mana nilai benar dan

bebas dari kesalahan terhadap data yang diamati. Menurut Hair dkk. (2010)

semakin besar nilai reliabilitas, maka akan semakin besar pula konsistensi yang

didapatkan.

Pengujian reliabilitas juga dapat dilakukan pada SPSS dengan beberapa langkah
tertentu. Menurut Ramadhayanti (2019) langkah-langkah pengujian uji reliabilitas
melalui SPSS adalah sebagai berikut.

i. Buka software SPSS dan pilih Menu File > Import > Excel.
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ii. Setelah data Excel terimpor, langkah selanjutnya adalah dengan klik Analyze >
Scale > Realibility Analysis

iii. Tekan ‘Ctrl+A’ dan pindahkan semua profil ke kotak sebelah kanan dengan
menekan tombol kanan.

iv. Pilih model ‘Alpha’ agar sistem menggunakan rumus Alpha Crombach.

v. Klik ‘OK’

2.2.8. Analisis Multivariat

Menurut Hair dkk. (2010) definisi dari analisis multivariat adalah seluruh metode
analisis statistik yang secara simultan dapat menganalisis banyak pengukuran
kepada individu maupun objek dalam satu penelitian. Analisis ini adalah lanjutan
dari analisis statistik univariat dan bivariat. Dasar dari analisis multivariat
merupakan nilai variat yaitu sebuah persamaan linier yang mengkombinasikan
variabel dan bobot yang ditentukan secara empiris. Nilai variat dapat ditentukan

melalui persamaan (2.1).
Nilai variat = w1. X1+ W2. Xo+ W3. X3+...+ Wn. X (2.2)

Keterangan:
W = Bobot variabel
X = Variabel yang dicari

Analisis multivariat memiliki dua cara untuk mendapatkan arahan terkait metode-

metode apa yang akan digunakan berdasarkan kebutuhan penelitian. Cara

pertama adalah dengan memberikan tiga pertanyaan terhadap studi kasus

tersebut. Menurut Hair dkk. (2010), pertanyaan tersebut adalah sebagai berikut:

1. Berdasarkan beberapa teori, apakah variabel yang akan digunakan dapat
dibagi menjadi variabel dependen dan independen?

2. Apabila dapat dibagi, ada berapa variabel yang digunakan?

Bagaimana variabel dependen dapat diukur?

Cara kedua adalah dengan menggunakan gambar yang terlampir pada Lampiran
9. Pada gambar tersebut telah ditunjukkan seluruh alur pendekatan pemilihan
metode yang akan digunakan sesuai dengan kasus dan kondisi yang dihadapi.
Pemilihan metode menggunakan gambar pada Lampiran 9. dapat dipadukan
dengan ketiga pertanyaan tadi. Namun perbedaannya, pertanyaan tadi lebih
mengarah ke analisis menggunakan variabel dependen, sehingga untuk

mengetahui metode yang menggunakan variabel interdependen dapat dilihat pada
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bagian kanan gambar. Pedoman dalam membaca gambar pada Lampiran 9.
adalah persegi panjang menunjukkan metode yang digunakan dan segi enam
menunjukkan poin keputusan yang menjadi acuan pemilihan metode. Dengan

kedua pedoman ini, penentuan akan menjadi lebih mudah bagi peneliti.

2.2.9. Structural Equation Modeling

Menurut Hair dkk. (2010), Structural Equation Modeling (SEM) merupakan sebuah
model statisika yang dapat menjelaskan hubungan antar measured variable dan
latent construct (variabel dependen dan independen) dengan penggabungan dua
analisis teknik multivariat yaitu analisis jalur dan analisis regresi berganda.
Berdasarkan Hair dkk. (2010), berikut merupakan langkah-langkah pembuatan
model SEM.

1. Mengembangkan Model

Hair dkk. (2010) menyatakan bahwa dalam pengembangan sebuah model SEM,
konstruk yang digunakan harus didukung oleh teori yang kuat berdasarkan para
ahli. Mulai dari penggunaan pengukuran skala dan tipe skala. Skala yang sering
ditemukan pada saat melihat pengukuran konstruk adalah skala likert atau skala
semantic differential kepada beberapa indikator di setiap konstruk. Model
pengukuran yang dianggap lengkap menurut Hair dkk. (2010) adalah model
dengan hasil pengukuran hubungan antara item dan konstruk, adanya hubungan
korelasi antar konstruk, dan adanya error terms di setiap item. Gambar 2.6. telah

menunjukkan contoh dari model yang dianggap lengkap.

Gambar 2.1. Model Pengukuran SEM (Hair dkk., 2010)

2. Mengembangkan Diagram Jalur
Setelah mengembangkan model, langkah selanjutnya adalah pengembangan

diagram jalur yang digunakan. Diagram jalur akan membantu melihat hubungan
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yang ada antar variabel pada model yang akan diuji. Pada Gambar 2.3. telah

dijabarkan sebuah diagram jalur sederhana untuk model SEM.

Environment

Gambar 2.2. Diagram Jalur SEM (Hair dkk., 2010)

Berdasarkan Gambar 2.3., diagram jalur yang dibentuk memiliki dua jenis

kelompok konstruk yaitu konstruk endogen dan eksogen. Konstruk eksogen

merupakan konstruk yang hanya memiliki hubungan korelasi dengan konstruk
lainnya dan berperilaku sebagai variabel independen dalam hubungan struktural.

Konstruk yang merupakan eksogen dalam Gambar 2.3. adalah supervision, work

environment, dan coworkers. Konstruk endogen adalah konstruk yang berperilaku

seperti variabel dependen dan seluruh jalur hubungan mengarah ke konstruk ini.

Konstruk yang termasuk ke dalam konstruk endogen adalah job satisfaction dan

job search.

3. Mengkonversi Diagram Alur ke Bentuk Persamaan

Proses konversi diagram alur ke bentuk persamaan memiliki hasil berupa dua jenis

persamaan. Persamaan tersebut antara lain:

a. Persamaan struktural yang menghasilkan persamaan hubungan kausalitas
antar konstruk model. Persamaan yang terbentuk telah dijabarkan pada
persamaan (1.5)

Variabel Endogen = variabel endogen + variabel eksogen + eror  (1.5)

b. Persamaan spesifikasi model terukur yang ditemukan melalui beberapa
rangkaian matriks korelasi sehingga menghasilkan proses hipotesa antar
variabel.

4. Penguijian Validitas dan Reliabilitas pada Konstruk

Pengujian ini bertujuan sebagai alat untuk menghasilkan sebuah model yang baik

untuk diuji oleh SEM. Hair dkk. (2010) menyatakan bahwa untuk menguiji validitas

dan reliabilitas konstruk dapat menggunakan metode Confirmatory Factor Analysis
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(CFA). Sebuah indikator konstruk dikatakan valid apabila loading factor yang
dihasilkan melebihi 0,5. Lalu konstruk yang diuji dapat dikatakan reliabel apabila
nilai construct reliability minimal 0,6. Nilai construct reliability dapat dihitung melalui

persamaan (1.6).

construct-reliability = (Zgitgazc;sgg';i) ; < (1.6)
Keterangan:
Std Loading = standardized loading
Ej = nilai error pada indikator konstruk ke-j

Apabila terdapat sebuah konstruk yang tidak valid atau tidak reliabel, maka
konstruk tersebut dapat dieliminasi agar nilai model struktural yang nanti dapat
memenuhi uji goodness of fit.

5. Pengujian Asumsi SEM

Sebelum memasuki uji goodness of fit, sebuah model yang baik merupakan model
yang memenuhi uji asumsi multivariat seperti ukuran sampel yang baik, normalitas
,dan outlier (Ghozali, 2011). Tabel 2.1. menjabarkan mengenai kriteria sebuah

model yang lolos uji asumsi SEM.

Tabel 2.2. Asumsi SEM

Asumsi SEM Kriteria Sumber

Ukuran Sampel Melebihi setidaknya 100 sampel | Ghozali (2011)

_ Nilai P-value Kolmogorov- _
Normalitas _ _ _ Ghozali (2011)
Smirnov lebih dari 0,05

_ Tidak ada korelasi antar variabel
Korelasi Santoso (2015)
yang 20,5

Nilai mahalanobis tidak melebihi
Ouitlier nilai chi-square dengan degree of | Ghozali (2011)

freedom yang ditentukan

6. Pengujian Goodness of Fit

Suatu model struktural SEM dapat dikatakan baik apabila memenuhi salah satu uji
kelayakan model (Hair dkk. dalam Haryono dan Wardoyo, 2012). Uji kelayakan
model tersebut antara lain Chi-square, Degree of Freedom, Goodness Fit Index,
Root Mean Square Error of Approximation, Root Mean Square Residual, dan
masih banyak lagi. Pada Tabel 2.4. telah dijabarkan mengenai kriteria sebuah

model yang lolos uji kelayakan model SEM.
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Tabel 2.3. Kriteria Uji Kelayakan Model SEM

qu odness Nilai batas Kriteria Sumber

-fit Index

Chi Diharapkan kecil Good fit | Byrne (1998)

square

P-value =0,05 Good fit | Wijanto (2008)

CFI 20,9 Good fit | Wijanto (2008)

RMR <0,05 Good fit | Hu dan Bentler (1995)

GFI 20,9 Good fit | Ghozali (2011)

AGFI 0,85 <AGFI<0,9 Good fit | Wijanto (2008)

RMSEA <0,08 Good fit | Schermelleh-Engel dkk. (2003)
CMIN 2<CMIN<3 Good fit | Joreskog & Sorbom (1993)
TLI 20,9 Good fit | Ghozali (2011)

PGFI Antara 0 hingga 1 Good fit | Ghozali (2011)
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